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Source:

http://www.tech—archive.net/Archive/WinXP/microsoft.public.windowsxp.help_and_support/2009-07/msg02.

* From: "Richard" <richard @ XXXXXXXXXX>
* Date: Fri, 31 Jul 2009 10:47:11 —-0400

Hi Harold,

I have included some excerpts below from some of your previous messages,
going back a couple of years, that possibly have some clues related to your
current Excessive Hard Drive activity problem. Apparently you have had to
resort to reinstalling the Operating System (OS) on more than one occasion,
and have had Service Pack 3 (SP3) install misfires, and continue to have
various problems. But first, | noticed in one of the replies to you, quotes

from one of your messages that did not appear here, so there is possibly a
problem with your newsfeed. In your message headers, | noticed this:

From: Harold A. Climer <Harold-Climer AT utc DOT edu>

Newsgroups: microsoft.public.windowsxp.help_and_support

Subject: Re: Excessive Hard drive access after defragmentation

Date: Sun, 12 Jul 2009 11:33:46 —0400

X-Newsreader: Forte Agent 4.2/32.1118

Path:
TK2MSFTNGPO1.phx.gbllTK2ZMSFTFEEDSO02.phx.gbl!newsfeed00.sul.t—online.de!t-online.de!news

You are located in Tennessee, but your messages appear to be routed through
Germany. You might have more reliable results connecting directly to the

FREE msnews.microsoft.com newsfeed. You may need to check Internet Options,
Programs (tab) to see if your newsreader is properly selected, and then

click this next line, or paste it into the address bar of Internet Explorer:

news:msnews.microsoft.com/microsoft.public.windowsxp.help_and_support

Next, because of the complexity of your system, we need a more complete
picture of how your system is configured, in order to provide better
informed advice. At one point in the past, you described your system as
having two 400Gig hard drives, but in this thread, a 400GB drive with C and
D partitions, and the other drive, (or K partition only?) that has 300GB

with about 50GB of files.

Combining info from several past messages, the following appears to be your
current configuration, and feel free to make correction/additions:
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Computer Model: HP pavilion A1520N

OS: Windows XP Media Center Edition Professional
aka. "XP MCE 2005 Rollup2" [OEM? originally SP27?]
Age: 3 years? (OS 1st installed "almost 2 years" before 30May2008)
BN: Build Number 2600

SP: Service Pack 3

PF: Pagefile on C drive — System managed.

RAM: 3GB

CPU: 1GHz pentium 3

"AVI X 1300 graphics card"

"l have a ATl Radeon 7500."

DX: DirectX Version 9.0c (4.09.00.0904)

IE: Internet Explorer 8? [complete version number?]
Disk 1 = Master, 400GB, [Model? about half full?]

= C partition = "System" drive

= D partition = "System restore partition"

Disk 2 = Slave, 400GB, [Model? how full?]

= K partition [300GB with about 50GB of files?]

= L partition [LOOGB?]

Disk 3, O drive = Maxtor USB 1TB [USB 2.07?]
Monitor?

Keyboard?

Mouse? (PS2 or USB?)

Other hardware?

In one of your messages, | noticed "Weather.exe" in an error report.
Do you have weather station hardware linked to your computer?

Another thing you could do to help us understand your configuration:

How to Access System Information

click Start, click Run, type or paste next line, and press Enter:

msinfo32

(or Start> [all]Programs> Accessories> System Tools> System Information)

click System Summary in left pane

press ctrl+A keys (to Select All), press ctrl+C keys (to Copy)

Start a message reply here, and paste that into the message.

(Delete the System name and User name lines for privacy if you like.)
in msinfo32 again, in the left pane,

click +Components (expand the tree), click +Storage (expand the tree)
click Drives, press ctrl+A, ctrl+C, and paste that into the message.

in msinfo32 again, below Drives, click Disks, press ctrl+A, ctrl+C

and paste that into the same message also.

further down in msinfo, click Problem Devices.

if any listed, press ctrl+A, ctrl+C and paste into message

(Thanks. )

Now, back to the current thread:
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"Harold A Climer" <Harold-Climer AT utc DOT edu> wrote:

HC> | have an HP pavilion A1520N computer running Windows XP MCE with
HC> SP3 installed. | have two hard drives installed with partitions

HC> C and D on the master drive and K and L on the slave drive. | also

HC> have a Maxtor USB 1 TB drive as the O drive.

HC> The D drive is the system restore drive.

Elsewhere you referred to a system drive and a "recovery" drive. By "system
restore" do you mean your System Restore "Points" information is stored
there, or is the D drive the original computer's Recovery partition?

HC> In the last week | decided to de fragment all my drives since it has
HC> been since Christmas vacation since | did it last. After doing this
HC> | noticed that there was a large increase in disk access compared
HC> to before de fragmentation. At times the little yellow disk activity
HC> light is on almost constantly on and for long periods of time.

Was that 1st defrag done with Norton Speed Disk or Windows defrag?

HC> | also noticed that since de fragmentation it seems as if the

HC> computer sometimes locks up. By this | mean that after closing a
HC> program it takes quite a while for another program to respond to
HC> a mouse click to get it started or to access the Start menu, etc.

There could be a common underlying problem, or that is separate.

HC> Using Norton Speeeddisk | have only been able to only get down
HC> to 25% fragmentation from about 46%.

HC> When | used the Windows defragmenter utility it reports

HC> from 2% down to less than 1%.

HC> Both programs report some files can't be defragmented.

HC> (Volume information files (Restore Point information | think)

The first thing to keep in mind about defragmentation is that fragmented

files that are NOT being accessed have little or no effect on anything.

It's common for a pagefile to have 1 fragment. You can get somewhat better
defrag results if you start in Safe Mode and use Windows Disk Defragmenter.
A web search on Norton Speeddisk Problems turned up a lot of reports of
problems with the peculiar way Norton, not only defrags, but apparently
rearranges files; and | saw some reports where fragmentation after using
Norton was greater, even as reported by the Norton utility.

In an old October 2007 thread, | found where a man had noticed that his
drive was constantly being accessed, even though he had not transferred any
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files, and he said: "It's then that | thought maybe Diskeeper was for some
reason accessing this drive. | opened Diskeeper and saw that Automatic
Defragmentation was enabled. | disabled this and haven't had any problems
with my drive since." It may be that Speeddisk has a similar feature.

HC> Does anyone know if there is malicious software out there that
HC> deliberately increases the fragmentation of a hard drive?

Duh. (If it's "out there" and not IN your computer, why worry? :)

I've heard reports of viruses that supposedly destroy drives by putting them

in some kind of endless access loop. | would suppose there could be over
heating problems in such a case that might mess up the electronics.
Yesterday, while doing a FULL Malwarebytes scan on another computer here,
the computer fan switched to high speed for nearly 15 seconds.

Besides the anti-spyware scans that you have done, if you haven't done so
yet, download and run the free (Home edition) Avast! antivirus program, and
update Avast, then disconnect from the internet, disable your current AV and
its firewall, enable Windows firewall, (and if you have Windows Defender,
you can leave it enabled,) and run a full scan. Be sure to check your D
partition with all anti malware programs before you rely upon it to

reinstall the OS. (Although more than one antispyware program can in some
cases be run at the same time, it is best to run only one antivirus program
and have one firewall active at a time. Router firewalls excepted.) Do not
connect to the internet without a firewall and antivirus program active.

FREE Home Edition Avast! antivirus — anti-spyware protection
http://www.avast.com/eng/avast—free—home—antivirus—antispyware.html

By the way, a lot of people have suggested you download and use various
diagnostic tools and utilities. | would suggest that you keep a copy of the
installation software, but uninstall any that you do not currently need.

HC> Could it be that the hard drive controller on the motherboard is
HC> flaky?

Possibly, but probably not. There might be a more up to date disk
driver available on the drive manufacturer's web site.

HC> The excessive read or writes is still occurring. Each event lasts
HC> from 15 to 45 seconds or more (I have timed it). During this time
HC> the computer is unresponsive to mouse clicks or movement of
HC> icons etc using the mouse.
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(Someone else already mentioned that Norton is a "resource hog"... :)

HC> Handles 20151 Physical Memory 3144172
HC> Threads 670 Available 2364672
HC> Processes 71 System Cache 2478716

Compare that with my XP-Pro-SP3, 3Ghz Pentium 4, 1GB-RAM computer:
Currently | have 7293 Handles, 352 Threads, 29 processes. My pagefile usage
(Commit Charge) is 240M / 2444M (about 10% — The highest | have ever seen is
21%). On my taskbar | currently have one folder open, 2 applications, this
message draft, and Task Manager. Every 66 seconds, there is an 18% spike for
about 4 seconds on the CPU Usage graph when sqglservr.exe does whatever it
does - otherwise both graphs are pretty much flat lined.

HC> The above values were taken during very low disk activity.
HC> None of the other reading changed very much during the
HC> unusual disk activity.

Which tells you the disk activity is not related to memory usage, and
therefore not a pagefile problem. Besides the aforementioned possibility of
Automatic defrag, Twayne mentioned the possibility of file Indexing or
anti-virus scan during idle times. | can't see how any of those would cause
delayed mouse clicks or program start and close delay. USB keyboard? USB
mouse? Wireless mouse with old battery? Keep in mind that most modern
antivirus programs have the ability to check ZIP archive files, (I think,)

by uncompressing files to a temporary folder to check them, and then of
course, deleting the temporary files. If that is the case, | would think

that there would be both excessive drive activity, and a lot of file
fragmentation. Do you use Compressed (ZIP) Folders for active files?
(Since the Windows Search includes text search within files, I'm wondering
if the Indexing service that runs in the background might also access zip
files to build a keyword index? Microsoft Office document indexing?)

Since my computer has a dual core processor, is there a utility that
looks at each processor individuallly to see what each one is doing?

I have no experience with dual core processors, but in (Alt+Ctrl+Del) Task
Manager, when the Performance tab is active, the View menu has an additional
"CPU History" item with "One Graph Per CPU" toggle, which has no observable
effect on my single processor system. Let us know if it works for you.

Also, besides studying Processes in Task Manager, you can access more
comprehensive information in msinfo32 System Information. Maximize the
window, and click + Software Environment (expand tree), click Running Tasks.
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The total number of columns is too wide to fit into the 76 character line
length limit in these Usenet newsgroups, but you can ctrl+A, ctrl+C that

info and paste into Notepad, or Wordpad, or MS Word. You might want to
ctrl+A, ctrl+C, capture (and paste) info while you are not getting disk
chatter, and then when you get abnormal disk activity, on the msinfo menu
bar, click View> Refresh, and ctrl+A, ctrl+C capture/paste and compare with
the previous info. When you click on the column headers to arrange the info
various ways, you need to click View> Refresh, for it to update the order.

The next item in the left pane tree after Running Tasks is Loaded Modules,
which also has a LOT of useful (and somewhat mysterious) information. Click
HELP on the menu bar, and read all the topics related to the System
Information. (Things were simpler back in the Atari computer days. :)

If you have not done so already, you ought to run a full Error Checking

(CHKDSK) surface scan of the hard drive. In Command Prompt, type:

"CHKDSK /R C:" (without quotes) and press Enter key. Answer yes to run on
restart, and reboot the computer. When the scan completes it will probably

restart. (Avoid running CHKDSK when there is possibility of storm induced

power outage, or brownouts at the time people arrive home from work and all
switch their air conditioners to maximum.) Remember that if you get screen
messages during startup, you can press PAUSE/BREAK key to pause, so you can
write down the complete message, including error codes, and press CTRL+PAUSE
to resume. Another thing you should probably do right now is, hold your

WinLogo key and press Pause, for System Properties, and click Advanced

(tab), and in Startup and Recovery, click Settings, and UN-check

Automatically restart.

(Pause works in [DOS] Command Prompt also, but press Enter to resume.)

That is all | can think of concerning your current problem(s). Here are some
excerpts from previous problems in older threads, mainly SP3 issues, which
may shed some light on these matters:

25 Jan 2008 - by Harold Climer:
Last week | downloaded XP SP3 from Microsoft's site and installed it.

Not able to get Windows to boot normally The only way was able to get
things back to normal was to reformat the hard drive and reinstall the
OS from my recovery patrtition. | tried to install SP 3 again with a

fresh install of the OS and the same thing happened.

15 May 2008 - by Harold A Climer

Subject: Problem Downloading XP SP3 on Vista Machine.

| want to download XP SP3 and install it on my XP machine at home.
However | only have dial- up at home and the SP file is humongous.
I will have to re-format my hard drive and re—install Media Center
Edition because of some glitches, so | want the whole 550+ MB__file.
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| have a Vista machine at work, so | thought | would download it there
because | have T1 connection. However when | go to the download page
for XP SP3 the download button does not appear on the page. It is not
grayed out it is just not there. When | go to the same page on my
computer at home the download button is just where it is supposed to
be. What gives? Is there a direct link where | can download the file

on any machine?

30 May 2008 - by "Harold A Climer"

I have a HP A1520N computer with Media Center Edition 2005
installed.

It has been almost 2 years since the OS was first installed and the
system is in need of having the OS re-installed.

The system is acting a bit flaky and some programs that | have
installed are not working well or not working at all, after |
re—installed them. (After a crash)

| was wondering what was the best way to accomplish this?

BTW as far as | can tell it is not a hardware problem.

1. Should I use the recovery partition or use the recovery CD's that |
got from HP?

2. Should I uninstall all my software before | do this or just leave

it on the Hard Drives.

3. If  use the CD's does the installation program re—format the hard
drives?

Note: | have two 400Gig hard drives on this machine now

One is for data and one is for the OS and programs.

It is best to format (erase partition) and clean install Windows.
Any program installed on another drive needs to be reinstalled.
(Back up all your data from the Master drive to be safe.)

4 Aug 2008 - by Harold A Climer

Subject: Windows XP SP3 Reboot problem

Is there a version of XP SP3 that already takes into account that the
original OS image file came from a computer with an Intel CPU as
opposed to an AMD CPU that is on my Pavilion A1520N?

| tried installing XP SP3 on my Pavilion A1520N and got the
repeating re—boot problem. | finally had to reinstall the whole OS
from the recovery disks a got from HP. | do not want to have to do
that again, and | am a bit leery of fooling around with the registry.

17 Oct 2008 — by Harold A. Climer

Recently | had to re-install my OS;Windows XP Media Center Edition
2005. | also installed SP3 after using the HP patch program for
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AMD processors before | installed anything else.

OK, Harold, Is that the point of success with the SP3 install? Or has there
been another install between then and now? You seem to have the correct
installation order: Install the OS, install SP3, access only the Windows
Update internet site until all security updates and other patches are
installed. The first non system software to install is antivirus/antispyware
programs. It is best to install programs one a time, and give each a good
shake down, before installing the next one. Service Packs are cumulative, so
you can upgrade directly from SP1a to SP3 without installing SP2 first. To
install SP3 you only need at least one prior service pack. SP3 needs to be
installed before any IE upgrades. You can upgrade directly from IE6 to IES.
(Don't forget to "export" your Favorites [and any Cookies with website
preferences] before IE upgrade or downgrade.)

Steps to take before you install Windows XP Service Pack 3
http://support.microsoft.com/kb/950717/

How to configure Windows XP to start in a clean boot state
http://support.microsoft.com/kb/310353/

IEBlog: IE and Windows XP Service Pack 3
http://blogs.msdn.com/ie/archive/2008/05/05/ie—and—xpsp3.aspx

Error message after you upgrade a computer that uses a processor other than
an Intel processor to Windows XP Service Pack 2 or to Windows XP Service
Pack 3: "STOP: 0x0000007E":

http://support.microsoft.com/kb/953356/

HP and Compaq Desktop PCs: Computer Restarts after Displaying Stop Error
0x0000007E [after installing WinXP SP3]
http://h10025.www1.hp.com/ewfrf/wc/document?lc=en&dlc=en&cc=us&docname=c01457284

Thu May 28, 2009 - by Harold A. Climer

| have installed IE8 several times on my HP A1520N computer. It crashes
upon boot up. Luckily MS has the Fixit program to get back to IE7.

Any ldeas to what might be going on? | do not really need IE8, but

| heard that it was more stable, etc. than IE7.

IE8 Tips, Caveats and Helpful Links
http://aumha.net/viewtopic.php?f=7&t=38848

Release Notes for Internet Explorer 8 — Read before installing
http://msdn.microsoft.com/en—-us/ie/dd441788.aspx

How to Solve Internet Explorer 8 Installation Problems
http://support.microsoft.com/kb/949220/
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About IE7 (and higher) Installation and Anti-Malware Applications
http://blogs.msdn.com/ie/archive/2006/10/11/IE7-Installation—and—Anti_2D00_Malware—Applications.aspx

About IE7 & IE8 and Windows XP Service Pack 3
http://blogs.msdn.com/ie/archive/2008/05/05/ie—and—xpsp3.aspx

Download links for IE8 Final
http://www.microsoft.com/windows/internet—explorer/worldwide—sites.aspx

No-charge support for Internet Explorer 8 installation, set-up and usage

(only) is available via the phone based on your locale through 31 December

2009. Customers must be running Windows XP or Windows Vista in a non—-domain
environment.

=> US & CA Residents: 1-866-234-6020

=> QOther locales: https://support.microsoft.com/oas/default.aspx?&prid=13043

IE8 recommendations from "PA Bear [MS MVP]" include:
=> |nstall IE8 manually, not via Windows Update/Automatic Updates!!

=> Uninstall all third—party toolbars (e.g., Google; Yahoo; Windows Live)
and third—party Windows Themes before installing IE8.

=> Close all open applications (i.e., anything with a taskbar icon) before
installing or uninstalling IE8.

=> | would strongly recommend disabling your anti-virus application and any
anti-spyware application's "system protections" (other than Defender's)
before installing (or uninstalling) an IE upgrade. If you're running a
third—party firewall, | would recommend disabling it and then enabling the
Windows Firewall before installing (or uninstalling) an IE upgrade.

=> Create a Restore Point manually before installing IE8. [Do NOT use
System Restore to remove/uninstall IE8; instead, see
http://support.microsoft.com/kb/957700. Then use the Restore Point prior to
reinstalling IE8 per these recommendations. Norton users will need to see

http://bertk.mvps.org/html/symantecdocl.html.]

=> Reboot twice after installing or uninstalling IES.

=> For best chance of success with IE8, make certain that your anti-virus
application, any anti-spyware applications (other than Defender), and your
third—party firewall (if any) are supported in IE8 Final before you decide

to install it.

(Hint, hint:) How to uninstall Norton products:

1. Download the Norton Removal Tool, to your desktop (do NOT Run it yet.)
http://servicel.symantec.com/SUPPORT/tsgeninfo.nsf/docid/2005033108162039
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2. Disconnect from the internet and close all programs, and reboot.
3. Uninstall Norton with Control Panel> Add/Remove Programs.

4. IMMEDIATELY enable the Windows Firewall!

5. Double—click on the file you saved in #1 above to run the utility. Do

NOT touch your keyboard until the run has completed, then reboot (again).

6. Install other antivirus, such as Eset's NOD32, Kaspersky or Avast!

I'm hopefully looking forward to the resolution of all your problems. Let us
know how things work out. (Yes, | tend to write long—winded messages.)
THANKS for your time and patience.

(Triple—click here, to be of good cheer. )
——Richard
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